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1) What is Star Office? 

 Star Office is an application that is 

designed to work on different 

operating systems.  

 Star Office is a full-featured office 

productivity suite with powerful 

standalone applications that can also 

open, edit, and save Microsoft Office 

documents. 
2) What are the functions of Star office? 

 Create text document using Star Office 

Writer, Create spreadsheets using Star 

Office Calc, Create presentations using 

Star Office impress. 

 Draw using Star Office Draw; create a 

database using Star Office Base. 

3) Define Word processing? 

 Word processing refers to the activity 

carried out using a computer and suitable 

software to create, view, edit, 

manipulate, transmit, store, retrieve 

and print documents. 

 Star Office Writer is a word processor. 
4) List out some word processing packages? 

 Some of the available word processing 

packages are MS Word, Lotus AmiPro, 

Word Perfect, Word Star and Word 

Pro. 

 Star Office Writer is also a word 

processor. 
5) Define Insertion point? 

 As the characters are typed they appear 

on the screen and the flashing vertical 

bar called the insertion point, moves to 

the right.  

 This insertion point always indicates 

where the new text will appear 
6) How would you switch over from Insert 

mode to Type-over mode? 

 The user is in the type-over mode, if the 

text existing to the right of insertion 

point disappears, while typing a new 

text.  

 The user can toggle between type-over 

mode and the insert mode by using the 

Insert key. The status bar gives the 

information about the current mode 

(Insert or Type-over-mode). 
7) What are the two ways used to working 

with Multiple Documents? 

 1.  Click on the Window menu option 

and select the file from the list of 

documents displayed. 

 2. Click on the document button visible 

on the taskbar. 
8) Define text editing? 

 Entering a new text or  

 Modifying the existing text in a 

document is known as text editing. 
9) What are the uses of backspace and delete 

keys? 

 Backspace key deletes the characters to 

the left of the insertion point. 

 Delete key deletes the characters to the 

right of the insertion point. 
10) What is end-of-document marker? 

 The thick horizontal line in the page 

area is called the end of- document 

marker.  

 The insertion point cannot be beyond 

this line. 
11) What are the various formatting options 

available in Star office writer? 

 Star Office Writer offers a number of 

choices for formatting such as bold or 

italics, and defining the font, type, and 

font size.  

 Bold, italic or underlined are the most 

common types of text formatting. 
12) What is the use of colour printer? 

 With the help of a colour printer, some 

splash can be added to the documents 

by changing the colour of text.  

 In the absence of a colour printer, the 

document will be displayed on screen in 

colour. 
13) Define highlighting the text? 

 Highlighting can be used to call attention 

to key ideas or pointers in a document. 

When reading something important in a 

www.Padasalai.Net                                             www.TrbTnpsc.com

http://www.trbtnpsc.com/2013/07/latest-12th-study-materials-2013.html

www.Padasalai.Net



 
XII COMPUTER SCIENCE – 2 MARKS 

 

2 M SHYNI ME, COMPUTER SCIENCE, VIDYA JOTHI MATRIC.HIGH.SEC.SCHOOL,MARTHANDAM 

 

document the colour to be used for 

highlight the text. 

 These highlighted sections are used to 

review or find the key points in the 

document.  
14) Differentiate hard return and soft return? 

 A paragraph is any text followed by a 

hard return. A hard return is inserted 

every time when Enter is pressed.  

 Soft returns are inserted as line breaks 

by Star Office Writer and are adjusted 

when text is added or deleted. 
15) What is hanging indent? 

 The First line option can be used to 

indent the line of the paragraph. Using 

the spin arrows, if a positive value is 

specified, the first line will be indented.  

 A negative value will result in a 

hanging indent; that is, the first line 

will hang outside the paragraph. 
16) How do you change line spacing? What 

are the different line spacing options? 

 Select the paragraphs that need to be 

changed. Select Format → Paragraph. 

Click the Indents & Spacing tab.  

 Click on the Line spacing drop-down 

list box, and select the required line 

spacing option. Click the OK button. 

 Line spacing options: Single line, 1.5 

lines, Double, Proportional, At least, 

Leading and Fixed. 
17) Define style? 

 A style is a named set of defaults for 

formatting text. 

 For example, a word is to be made as 

bold, just the cursor is positioned in the 

word and the Bold icon is clicked. 
18) What are the help systems available in 

star office? 

 Online help 

 Help Agent 

 Help Tips 

 Extended Help Tips 
19) Define help agent? 

 Help Agent that appears automatically 

when you perform a complex task. 

 The Help Agent opens the help topic for 

the task. 
20) Differentiate Hard Formatting and Soft 

Formatting? 

 Hard formatting deals with formatting a 

few pages of a document using tool bars 

icons, keyboard shortcuts keys and menu 

bars. 

 Soft formatting deals with formatting a 

large number of pages using styles. 

21) What are the two ways used to correct 

spelling mistakes? 

 1. Backspace key is pressed to delete a 

misspelled word and the word is retyped. 

 2. If the right spelling is not known, Star 

Office Writer can help the user with 

some choices. The misspelled word is 

right clicked. A pop up menu appears 

on the screen. If the correct spelling is 

shown, a click is made on that word. Star 

Office Writer makes the replacement. 
22) What is the use of AutoCorrect option? 

 Star Office Writer will automatically 

correct some spelling mistakes. Star 

Office Writer recognizes some common 

misspellings and typographical 

mistakes and makes the replacement 

automatically.  

 For instance, if a word is typed as “teh”, 

Star Office Writer automatically replaces 

this with the correct word “the”. 
23) How will you correct spelling mistakes 

while typing? 

 Star Office Writer has an automatic 

spell-check feature that can check for 

possible spelling mistakes even as the 

document is being typed. 

 When Auto Spell check feature is ON, 

Star Office Writer compares each word 

typed with the words in the dictionary 

and underline words that do not match 

with a squiggly red line. These red lines 

can be ignored and the typing work may 
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be continued. The correction can be 

made after the document is created. 
24) How will you make selected rows/columns 

of the same size? 

 Select the rows and columns that are to 

be resized.  To make all columns even, 

right click inside the table and select 

Column→ Space Equally in the pop-up 

menu. 

 To make all rows even, right click inside 

the table and select Row→ Space 

Equally in the pop-up menu. 
25) How to change the width of a 

row/column? 

 To resize a column, place the cursor in a 

table cell, hold down Alt, and then press 

the left or the right arrow. To resize 

the column without changing the width 

of the Table, hold down Alt+Ctrl, and 

then press the left or the right arrows. 

 To resize a row, place the cursor in the 

row, hold down Alt, and then press the 

up or the down arrows. 

 Alternatively if Table → Table 

Properties command is used one would 

get a Table Format dialog box. Choose 

the Columns tab and type column size 

in the Column Width spin boxes and 

click OK button to change the column 

width. 
26) How to insert row/column in a table? 

 To insert more than one row or column 

in the table, Table → Insert → Rows or 

Table → Insert → Columns command 

is used.  

 In a corresponding dialog box, select the 

rows or columns and the required 

quantity. If OK button is clicked the 

required number of columns or rows are 

added to the table. 
27) What is the default margin size? 

 The default margins are 1 inch top and 

bottom margins and  

 1.25 inches left and right margins. 
28) What is Page preview? 

 The Page Preview option in the File 

menu can be used to see the change. 

 This option gives an overall picture of 

the document and visually shows to the 

user, how the change has affected the 

document. 
29) Define two types of Page orientations? 

 Portrait - the length of a document will 

be more than the width. This 

orientation is called portrait.  

 Landscape- the width of a document 

will be more than the length. This type 

of orientation is called landscape. 
30) What does Page formatting mean? 

 The term Page formatting can also be 

used to describe the page layout or 

style of text in a word processing 

document.  

 We can change the layout of a page, 

changing page orientation; modify the 

page size, page margins, and line 

spacing. 
31) What is meant by Header and Footer? 

 Header is an area at the top of page and 

footer is an area at the bottom of the 

page. 

 The user can specify what he wants to 

display in this area and Star Office 

Writer will insert the specified text 

automatically on each page. 
32) What is an Electronic Spreadsheet? 

 An electronic spreadsheet is a worksheet 

used in a computer to create and quickly 

perform “What if” analysis of 

interrelated columnar data in 

workspaces. 

 A spreadsheet is like a grid of cells with 

a programmable calculator attached to 

each cell. 
33) Define Cell? And Cell address? 

 The intersection of rows and columns 

is called cell. The cells are addressed in 

terms of the row and column labels. 

 Address or formula given in the cell is 

called Cell address. 
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34) What are the applications of 

Spreadsheet? 

 Payment of bills 

 Income tax calculations 

 Invoices or bills 

 Account Statements 

 Inventory Control 

 Cost-Benefits Analysis 

 Financial Accounting 

 Tender Evaluation 

 Result analysis of students 
35) Write some popular Spreadsheet 

packages? 

 The popular spreadsheet programs are 

‘Excel from Microsoft Corporation 

‘Quattro Pro from Borland 

International, ‘Improve’ from Lotus 

Corporation and ‘Star Office Calc’ 

from Sun Microsystems. 
36) Differentiate Spreadsheet and 

Worksheet? 

 The term ‘spreadsheet’ has come to refer 

specifically to the software packages, 

while ‘worksheet’ refers to the files that 

you create with spreadsheet software. 
37) What is Active cell? 

 The active cell in which user wants to 

type the data is identified by the cell 

pointer which is a rectangular box 

covering that cell.  

 To begin with, the cell pointer is always 

in cell A1. 
38) Can we change the data present in a cell? 

 Yes. Type in the new data. The new data  

will simply overwrite the old contents 

of the cell. 

 Click on the formula bar with the mouse, 

press the F2 function key or simply 

double-click on the cell. A vertical 

cursor appears on the formula bar. Move 

the cursor to the left using the left arrow 

key or the backspace key and edit the 

data. 
39) Explain two types of cell referencing? 

Relative cell addressing  

 It is the default type of cell addressing 

used by Star Office Calc.  

 Formulae are automatically 

recalculated every time the contents of 

the cells used in the formulae change. 

Absolute cell addressing. 

 A cell address can be made absolute by 

using the $ (dollar) sign in front of row 

and column names.  

 For example, the C4 becomes absolute 

when you enter it as $C$4. 
40) Write about SQRT function? 

 SQRT function is used to find the square 

root of a number. Place the cursor in the 

cell where you want to insert the 

function and click on the Function 

Wizard icon.  

 Select Mathematical from Category. 

Select the SQRT function from the list 

of functions, which appears by double 

clicking on it. 
41) In Star Office Calc, What is Function? 

 Functions are predefined formulae that 

are available in Star Office Calc. 

 These functions are available in Star 

Office Calc in the pull down menu of 

Function Wizard window. Eg) SUM(), 

SQRT(). 
42) What is meant by AutoFill command? 

 AutoFill command automatically  

generates a data series based on a 

defined pattern. 

 It is also used to copy the contents of a 

cell to other cells. 
43) How will you calculate the difference 

between two dates? 

 To calculate the difference between two 

dates, 05/10/05 and 12/8/70. To do so, 

enter the two dates in two different cells. 

In a third cell enter the formula = first 

cell – second cell. The result will be 

displayed as 12572. 
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44) Define Range? 

 A continuous group of cells in a 

worksheet is called a Range.  

 A range is referred to by the range 

address. A range address is the address 

of the first cell in the range, followed by 

a colon, followed by the address of the 

last cell in the range. For example, the 

cells, G1, G2, G3, G4 and G5 can be 

called G1:G5. 
45) Define Page view? 

 The Page View option on the File menu 

can be used to preview a worksheet 

before printing. 

 Select the Page option from the Format 

menu.  
46) Define Data, Information and Variable? 

 Data - The data is as fact about people, 

places or some entities. The term data 

comes from the word datum, which 

means a fact.  

 Information – Information is defined as 

a set of processed data that convey the 

relationship between data considered. 

 Variable - The term variable refers to 

the name of a memory location that can 

contain only one data at any point of 

time. 
47) What is user-defined data type? 

 Users can define their own 

sophisticated data types is called user- 

defined data type. 
48) What is Manual Data processing? 

 The work has been carried out by long-

hand effort (or otherwise known as 

manual), this type of processing is called 

Manual data processing. 
49) What is Computerized Data processing? 

 If the school uses a computer to, 

• Prepare the mark lists, 

• Store the data, 

•Process the stored data for analyzing  

the results and 

• Print the results in a desired format, 

 Then we call this type of data processing 

as computerized data processing. 
50) What are the disadvantages of Manual 

Data processing? 

 Manual methods take more time. 

 In general human beings are liable to 

make computational and parallax errors. 

 Implementation of corrections, changes 

and modifications are tedious in manual 

data processing. 
51) Define Database? 

 A database is a repository of collections 

of related data or facts. It arranges 

them in a specific structure. 

 For example, a staff database of an 

educational institution such as “1001, 

Arul A., B.E. (CSE),Lecturer, Comp. Sc. 

& Engg. 27/01/97, 10000” 
52) Define File, Record, and Field? 

 File - The entire collection or related 

data in one table is referred to as a File 

or a Table.  

 Record - Each row in a table represents 

a Record, which is a set of data for each 

database entry.  

 Field - Each table column represents a 

Field, which groups each piece or item 

of data among the records into specific 

categories or types of data. 
53) What is meant by drag and drop? 

 Copy the data that is present in the 

spreadsheet and select the range to 

copy. 

 Just drag and drop the selected range 

into the presentation. 
54) What is Filter? Explain two types of 

Filter? 

 A filter is also a type of query. It is also 

used to select and display records, 

which match a certain condition.  

AutoFilter 

 The AutoFilter icon is available on the 

toolbar. Click on this icon to display 

only the records, which match the value 

of the current field. 
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Standard Filter 

 Filter used with a condition called 

Default Filter. The condition can be 

specified by clicking on the Standard 

Filter icon on the toolbar. 
55) What is Primary key? 

 A Primary Key is a field (or a 

combination of fields) in a table that 

uniquely identifies every record in the 

table. For example, RegNo in the Mark 

list, it uniquely identifies a student’s 

record. 

 A small yellow key appears to the left of 

RegNo, to mark it as the primary key. 
56) Define Record pointer? 

 The record pointer is a small triangle on 

the left most column of the table. 

 Right click on the record pointer of the 

selected record. 
57) What is multiple sorting? 

 Multiple sorting means sorting on more 

than one field of a table at the same 

time.  

 Click Sort Icon. The records will be 

displayed in the sorted order.  

 For example, Mark list table.  
58) What is SQL? 

 SQL(Structured Query Language) 

 It is designed specifically for  

communicating with a database using 

statements that are closer to English 

than to programming languages. 
59) What is the purpose of SQL? 

 Search the database to locate records 

 Establish relationships or links between 

tables to update records. 

 List a subset of records. 

 Perform calculations. 

 Delete obsolete records 

 Perform other data management tasks. 
60) Define Form? 

 A form is simply a screen that displays 

the fields of a record in a well-spaced 

out manner.  

 The appearance of a form can be 

customized to your liking. 
61) What is Report? 

 A report is printed information that is 

assembled by gathering data based on 

user supplied criteria. 

 Reports can range from simple list of 

records to customized formats for 

specific purposes. 
62) What are the Difference between Query 

and Filter? 

 Queries can be saved for later use. It 

does not affect the original table. 

 Filters cannot be saved for later use. It 

affects the original table. 
63) What is Data processing? 

 Processing means to do some 

operations or computations on the data 

of different variables to relate them so 

that these data, when related, convey 

some meaning. 
64) What are Queries? 

 Queries are special views of the data in a 

table. 

 Queries are user-constructed 

statements that set conditions for 

selecting and manipulating data in one or 

more tables and assembling the criteria 

matching data into information. 
65) What is Multimedia? 

 Multimedia is a computer-based 

presentation technique that incorporates 

text, graphics, sound, animations, and 

video elements. 

 Multimedia is commonly used include 

entertainment, education, research, 

and business communications. 
66) Define MMS? 

 MMS (Multimedia Messaging System) 

is an application that allows you to send 

and receive messages over cell phones.  

 These are popularly being used to send 

and receive jokes, music, ringtones, 

pictures and sometimes even videos. 
67) Define Interactive Multimedia? 
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 Multimedia applications that allow users 

to actively participate instead of just 

sitting by as passive recipients of 

information are called Interactive 

Multimedia.  

 An example is interactive multimedia 

games. 
68) Give name some image formats? 

 GIF files, JPG files, Animated GIF files, 

MPEG files, Shockwave files and 

NxView files. 
69) Define GIF and JPEG? 

 GIF (Graphic Interchange Format) is 

limited to an 8-bit palette. GIF is best 

suited for storing simple graphic images 

with relatively few colors.  

 JPEG (Joint Photographic Experts 

Group) image files are a lossy format. 

All digital cameras have the option to 

save images in JPEG format. The JPEG 

format supports full color and produces 

relatively small file sizes. 
70) Name the special softwares used in the 

multimedia content? 

 Flash 

 Dreamweaver 

 Maya 
71) Explain steps for creating 3D animation? 

 Modeling-creating broad shapes and 

structures of object. 

 Animating-animate the object to define 

the motion. 

 Rendering-render the objects by giving 

attributes such as colors. 
72) What is Vector Graphics card? 

 Vector graphics help in rendering the 

image effectively on the screen. 

 Many vendors provide special hardware 

called vector graphics cards to improve 

the efficiency in the display of images. 
73) What is sampling? 

 Before including sounds in an 

application, you have to convert the 

analog sound waves into a digital 

format.  

 This conversion of analog sound waves 

to a digital format is called Sampling. 
74) What is Animation? Explain its types? 

 Animations are primarily used to 

illustrate or demonstrate an idea or a 

concept. Unlike videos that are usually 

taken from life, animations are based on 

drawings. 

 Cel-based animations consist of 

multiple drawings, each one a little 

different from the others. When 

displayed in rapid sequence, these 

drawing appear to move. 

 Object-based animations also referred 

to as slide or path animations are 

created by moving an object across a 

screen. These types of animations are 

usually seen in computer games. For 

example, a ball moving across the 

screen. 
75) What is Morphing and Warping? 

 Morphing is a technique by which you 

can blend two or more images to form 

a new image.  

 Warping is the technique of distorting 

a single image to represent something 

else. 

76) What is Compression? What are the two 
types of Video Compressions? 

 Compression is a technique by which a 

recurring set of information is identified 

and replaced by a single piece of 

information. 

 • Lossless compression – Provides a 

comparatively lesser ratio of 

compression and retains the exact 

image. 

 • Lossy compression – Provides a 

comparatively higher ratio of 

compression but results in some loss of 

quality. 
77) Define AVI, MIDI, MPEG and AIFF? 

 Audio Video Interleave (AVI) format 

was developed by Microsoft. It is 

supported by all computers running the 
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Windows operating systems. Videos 

files stored in the AVI format have the 

extension .avi. 

 Musical Instrument Digital Interface 

(MIDI) format is one that is commonly 

used for transferring music information 

between electronic music devices like 

synthesizers and sound cards in 

computers. Sound files in the MIDI 

format have the extension .mid or .midi. 

 Moving Pictures Experts Group 

(MPEG) format developed for video 

files while the MP3 format is used to 

store sounds (music). These formats 

offer good compression and high quality. 

Audio files stored in the MP3 format 

have the extension .mp3, or .mpga. 

Video files stored in the MPEG format 

have the extension .mpg or .mpeg. 

 Audio Interchange File Format 
(AIFF) format was developed by Apple. 

This is not a very popular format as it is 

neither cross-platform nor is it supported 

by all web browsers. Files in the AIFF 

format have the extension .aif or .aiff. 
78) Define Inline sound? 

 When sound or video is included as 

part of a web page, then it is called 

inline sound or video.  

 The disadvantage of using inline sound 

or video is that it plays automatically 

whenever the web page loads without 

giving the viewer any control. 
79) What is Virtual Reality? 

 The various multimedia components are 

coordinated with a technique called 

virtual reality. They provide an 

environment which is experienced by 

users as similar to reality.  

 This technique is used in some arcade 

games and also in flight simulators, to 

impart training to pilots, without having 

to go for a real flight. 
80) What is Plug-in? What is its advantage? 

 Plug-in is a helper application program 

that can be launched by the browser to 

help play sound or video. 

 Advantage: We can allow the viewer 

control some or all of the player 

settings. 
81) Name some 3D animated films? 

 Some of the Animated films are Finding 

Nemo, Polar Express, Ice Age, 

Sindbad, Pandavas, Hanuman. 
82) Write any four multimedia formats? 

 Popular multimedia formats: AVI, 

MIDI, WAVE, SND, MP3/MPEG, and 

QUICKTIME. 
83) What is Star office Impress? 

 Star Office Impress is the Star Office 

application that allows you create 

attractive and professional-looking 

presentations.  

 The application provides various tools 

that allow you to save and modify 

presentations, print them as handouts, 

and view presentations as slide shows or 

HTML pages. 
84) What is Master page? 

 This page can be used to specify basic 

background information that needs to 

be included in all the slides. 

 For example, you can insert a company 

logo to the master slide and it will 

appear in all the slides. 
85) What is the use of Handouts view? 

 It allows you to scale the slides so that 

several slides can fit into a page. 

 This view is typically used when the 

presentation is to be printed and 

distributed as a handout. 
86) What is Custom Animation? 

 This page displays various options that 

allow you to add or modify animation 

effects to elements of a slide. 
87) What is Slide transition? 

 This page displays various transition 

effects that can be attached to a slide 
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along with other options that allow you 

to control the transition of the slides. 
88) What is the use of Slide show icon? 

 A slide show is a series of slides, or 

pages, that present information on a 

specific topic. 

 To start a presentation, click the Slide 

Show icon on the Presentation Toolbar 

or choose Slide Show Slide Show or 

press F5.  

 The onscreen presentation starts 

automatically in the full- screen mode. 
89) What is the use of Navigator? 

 Using the Navigator, you can move 

from slide to slide quickly.  

 Open Navigator by choosing Edit   

Navigator or by clicking the navigator 

icon in the function bar. 
90) What is the use of slide sorter? 

 Slide sorter view allows us to view 

miniature images of all the slides in the 

presentation. It is also used to rearrange  

slides. 

 In this mode, all slides in the 

presentation document are displayed in 

reduced size.  
91) Define Object? What is the significance of 

an object? 

 An object is a group of related 

functions and data that serves those 

functions. 

 An object is a kind of a self-sufficient 

“subprogram” with a specific 

functional area. 
92) What is Encapsulation? 

 The mechanism by which the data and 

functions are bound together within 

an object definition is called as 

ENCAPSULATION. 

 Example: Bank account. 
93) Define Polymorphism? 

 The ability of an object to respond 

differently to different messages is 

called as polymorphism. 

 Example: draw(). 

94) What is Inheritance? 

 It is the process of creating new classes 

called derived classes, from the existing 

or base classes. This process of 

acquiring the Base class properties is 

called inheritance. 

 For example: Animals is called the base 

class, and Mammals and Birds are called 

derived classes. 
95) What is meant by “Rehearse Timings”?  

 Star Office assists you in defining the 

right rehearse timings for automatic 

slide changes.  

 Star Office records the display time for 

each slide, so the next time you play the 

show with automatic slide changes, the 

timing will be as recorded. 
96) What is Token? 

 The basic types are collectively called 

as TOKENS.  

 A token is the smallest individual unit 

in a program. 
97) Write the classification of tokens? 

 Tokens are classified into Keywords, 

Identifiers, Constants, Operators and 

Punctuators. 
98) What is Keyword? 

 Keywords have special meaning to the 

language compiler. These are reserved 

words for special purpose. 

 These words cannot be used as normal 

identifiers. Example: auto, break, case, 

const. 
99) Define Constant? 

 Constants are data items whose values 

cannot be changed.  

 A constant is of numeric or non-numeric 

type. 
100) What is Conditional operator? 

 A ternary operator (?:) is also called as 

conditional operator. (num1 > num2) ? 

“true”:”else”  

 The general syntax is E1 ? E2 : E3 

where E1,E2,E3 are operands. E1 should 
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essentially be of scalar type, E2 and E3 

are values or statements. 
101) What is Assignment operator? 

 = is the simple assignment operator. 

 It is used to assign the result of an 

expression (on the right hand side) to the 

variable (on the left hand side of the 

operator). 
102) What are Data types and its three 

categories? 

 Data Types are the kind of data that hold 

variables in a programming language. 

 Three categories: 

• User defined type 

• Built-in type 

• Derived type 
103) Define Escape sequences? 

 Special characters like tab, backspace, 

line feed, null, backslash are called as 

non-graphic character constants. 

These characters are represented using 

escape sequences. 

 Escape sequences are represented using 

characters prefixed with a backslash. 

104) What is implicit conversion? 

 It refers to data type changes brought 

about in expressions by the compiler. 

 For example, float f = 7.6; int x = f; the 

value stored in the variable x is 7, as 

float is converted to int. The compiler 

does this conversion automatically 
105) What is the use of const qualifier? 

 The const qualifier specifies that the 

value of a variable will not change 

during the run time of a program.  

 The const qualifier is used like any other 

modifier where the variable is prefixed 

with the keyword const followed by data 

type. 

 For example :const float pi = 3.14; 
106) How Pointer variable different from 

Ordinary variable? 

 Pointer variable holds the memory 

address. 

 Ordinary variable stores the value. 

107) Which are specific operators to 

C++? 

 The operators that are specific to C++ 

are 

 :: - scope resolution operator 

.* - dereference operator 

->* - dereference pointer to class 

member. 
108) Define String? 

 String Literal is a sequence of characters 

surrounded by double quotes. String 

literals are treated as array of 

characters.  

 Each string literal is by default added 

with a special character ‘\0’ which marks 

the end of a string. For example 

“testing” 
109) Define Operator? 

 Operator specifies an operation to be  

performed that yields a value. An 

operand is an entity on which an 

operator acts.  

 For example: RESULT = NUM1 + 

NUM2. NUM1 and NUM2 are 

operands. + is the additional operator, 

that performs the addition of the 

numbers. The result is stored in the 

variable RESULT. 
110) What is the use of sizeof operator? 

 It returns the size (memory 

requirement) in terms of bytes, of the 

given expression or data type. 

 Example: sizeof(int) will return the 

value 2. 
111) Define Type definition? 

  “Type definition” allows users to 

define such user defined data type 

identifier. The syntax: typedef   data_ 

type user_ defined_ data_ type_ 

identifier; 

 For example: typedef int marks;  
112) What is Enumerated Data type? 

 Enumerated data type helps users in 

creating a list of identifiers, also called 
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as symbolic numeric constants of the 

type int. 

 The syntax : enum data type identifier 

(value 1, value 2, … value n); 
113) Write the impact of modifiers? 

 unsigned modifies the range of the 

integer values as the sign bit is also used 

to store data. 

 long increases the bytes for a particular 

data type, thus increasing the range of 

values. 
114) Define Typecast? 

 Type cast refers to the process of 

changing the data type of the value 

stored in a variable. The statement 

(float) 7, converts the numeric constant 

7 to float type. 

 The syntax: (data type) <variable/value> 

or data type (variable/constant). 

115) Define Storage class? And its types?  

 Storage Class is a qualifier that can be 

added to a variable declaration.  

 The four storage specifiers are auto, 

static, extern and register. 
116) What are Built in Data types? 

 Built in Data Types are also called as 

Fundamental or Basic data types. 

 They are predefined in the compiler. 

Integral, Float and Void are the three 

fundamental data types. 
117) Define Void data type?  

 Void data type indicates the compiler 

that the function does not return a 

value, or in a larger context void 

indicates that it holds nothing. 
118) What are purposes of Void data type? 

 To indicate the function does not return 

a value. 

 To declare a generic pointer. 
119) What is Pointer? 

 A pointer is a variable that holds a 

memory address.  

 Pointers provide the means through 

which the memory locations of a 

variable can be directly accessed. 

120) Define Variable? 

 Variables are user defined named 

entities of memory locations that can 

store data. 

 Variable names may contain letters, 

numbers and the underscore character 

(_). Names must begin with a letter or 

underscore. 

 For Example, Num is a variable.  

 

 

 
121) What is modifier? 

 The modifier alters the base data type 

to yield new data type. 

 The long, short, signed and unsigned  

are qualifiers or modifiers that modify a 

built – in data type with the exception of 

void. 
122) What are the uses of operator 

asterix(*)? 

 Used to declare a pointer variable. 

 Used to display the contents stored at a 

location. 
123) Write note on identifiers? 

 Identifiers are also called as variables. 

 Variables are memory boxes that hold 

values or constants. 

 Example: a, test_sum, reg_no. 
124) How operators classified based on 

operand requirements? 

 Based on operand requirements 

operators are classified as Unary 

Operators, Binary Operators, And 

Ternary Operators. 
125) What is called association in C++? 

 The operands and the operators are 

grouped in a specific logical way for 

evaluation. 

 This logical grouping is called 

association. 
126) Write about assignment statements in 

C++? 

 An assignment statement, assigns value 

on the right hand side of an expression to 

int num; 
num = 5; 
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the variable on the left hand side of the 

assignment operator.  

 ‘=’ is the assignment operator. For 

example the different style of assigning 

values to the variables. Eg) num = 5; 
127) What are the various sections of a 

C++ program? 

 Include files 

 Declaration of variables, data type, and 

user defined functions. 

 main( ) function 
128) Define cout and cin? 

 Cout is standard output stream. The 

standard output stream normally flows 

to the screen display – although it can 

be redirected to several other output 

devices. 

 Cin is standard input stream. The 

standard nput stream represents the flow 

of data from input device – the 

keyboard, cin can read data from other 

sources. 
129) Define insertion and extraction 

operator?? 

 The << is called the insertion operator 

or put to operator. It directs the 

contents of the variable to its right to the 

object to its left. 

 The >> is the extraction or get from 

operator. It takes the value from the 

stream object to its left and places it in 

the variable to its right. The extraction 

operator (>>) extracts data from the 

input stream object (cin) and places the 

value in the variable(temperature) to its 

right. 
130) What are control statements? 

 Program statements that cause a jump of 

control from one part of a program to 

another are called Control Structures. 
131) Write about switch statement? 

 This is a multiple branching statement 

where, based on a condition, the control 

is transferred to one of the many 

possible points. 

132) What is loop? 

 Loops execute a set of instructions 

repeatedly for a certain number of 

times. 

 Loops are unconditionally executed at 

least once, if the condition is placed at 

the end of the body of the loop. 
133) What is the use of break and continue 

statement? 

 Break statement would exit the current 

loop only. Break statement accomplishes 

jump from the current loop. 

 Continue statement forces the next 

iteration of the loop to take place, 

skipping any code following the 

continue statement in the loop body. 
134) What are the rules for the formation 

of nested loops? 

 An outer loop and inner loop cannot 

have the same control variable, as it 

will lead to logical errors 

 The inner loop must be completely 

nested inside the body of the outer 

loop. 
135) What is function? 

 Functions are the building blocks of 

C++ programs. Functions are also the 

executable segments in a program.  

 The starting point for the execution of a 

program is main ( ). 
136) What are advantages of function? 

 Reduce the size of the program. 

 Induce reusability of code. 
137) What is meant by parameter? 

 Parameters are the channels through 

which data flows from the call 

statement to the function and vice 

versa. 

 The call statement communicates with 

the function through arguments or 

parameters. 
138) What is Inline function? 

 An inline looks like a normal function in 

the source file but inserts the function's 

code directly into the calling program. 
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 Inline functions execute faster but 

require more memory space. 
139) Define Scope? 

 Scope refers to the accessibility of a 

variable. There are four types of scopes 

in C++. They are: 

1. Local scope 2. Function scope 

3. File scope 4. Class scope 
140) What is the use of scope operator? 

 The scope operator reveals the hidden 

scope of a variable.  

 It is used to refer variables declared at 

file level. 
141) What is meant by return statement? 

 The statement that marks the end of 

function is return statement. 

 Return statement transfers control to 

the statement after call statement. 
142) What is Array? 

 An array in C++ is a derived data type 

that can hold several values of the 

same type. 

 An array is a collection of variables of 

the same type that are referenced by a 

common name. 
143) What are the two types of array? 

 Arrays are of two types: 

 One dimensional: comprising of finite 

homogenous elements. These are 

suitable ways for processing of lists of 

items for identical types. 

 Multi dimensional: comprising of 

elements, each of which is itself a one 

dimensional array. A two-dimensional 

array is an array in which each 

element is itself an array. 
144) Define strlen() function? 

 Returns the number of characters 
stored in the array. 

 Syntax : strlen (char *) 
145) Define strcpy() function? 

 Copies source string to target string. 

For example,strcpy (name, petname). 

 Syntax : strcpy (char *,char *) 
146) Define strcmp() function? 

 Compares the two given strings, and 

returns 0. if strings are equal, value >0, 

if string 1 is greater than string 2. 

Otherwise value less than 0. 

 Syntax : strcmp ( char*, char*) 
147) Write a note on write () function? 

 Write() is a member function of 

standard output stream. 

 The two parameters required for write() 

function are string identifier and 

number of characters to be displayed. 

 Eg) cout.write(name,5); 
148) What is the size of the array float 

num [4][6];? 

 Size of the Array=Number of elements 

* memory requirements for one 

element 

=4*6*4=96 bytes. 
149) Find the number of elements and 

memory size of the 2D array int 

product[2],[4]? 

 Number of elements: Rows x columns= 

2*4=8 

Memory size=2*8=16 bytes (2 bytes is 

required for integer). 
150) If int x[][2]={0,1,2,3,4,5}. Then what is 

the value of x[1][1]? 

 The value of x [1][1] is 3. 
151) Define Matrix? 

 A matrix is a set of mn numbers 

arranged in the form of a rectangular 

array of m rows and n columns.  

 Matrices can be represented through 2-D 

arrays. 
152) Define Array of strings? 

 An array of strings is a two-dimensional 

character array.  

 The size of first index (rows) determines 

the number of strings and the size of 

second index (column) determines 

maximum length of each string. 
153) Define Class? 

 A class is a way to bind the data and 

its associated functions together. 
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 The keyword class specifies user defined 

data type class name. The body of a 

class is enclosed within braces and is 

terminated by a semicolon. 
154) Write about static data members? 

 The static member variable is initialized 

to zero, only when the first object of its 

class is created. No other initialization is 

permitted 

 Only one copy of the member variable 

is created and is shared by all the other  

objects of its class type 

 Its scope or visibility is within the class 

but its lifetime is the lifetime of the 

program. 
155) What are the two parts of class 

specification? 

 A class specification has two parts : 

1) Class declaration 

2) Class Function Definitions 
156) What is Data Abstraction? 

 Instruments allowing only selected 

access of components to objects and to 

members of other classes is called as 

Data Abstraction.  

 Data abstraction is achieved through 

data hiding. 
157) What are Access specifiers? 

 The class body has three access 

specifiers , private , public and 

protected 

 The members that have been declared as 

private, can be accessed only from 

within the class 

 The members that have been declared as 

protected can be accessed from within 

the class, and the members of the 

inherited classes. 

 The members that have been declared as 

public can be accessed from outside the 

class. 
158) Define friend function? 

 Accessible by only its own members 

and  certain special functions called as 

      friend functions. 

159) What is meant by Data hiding? 

 The members and functions declared 

under private are not accessible by 

members outside the class, this is 

referred to as data hiding. 

 Data hiding is the key feature of object 

oriented programming ( OOPS). 
160) What is the use of dot operator? 

 The members of a class are accessed 

using the dot operator.  

 For example, the call statement to the 

function execute() of the class student. 

Example) stud.execute(); 
161) What is Function overloading? 

 The ability of the function to process the 

message or data in more than one 

form is called as function overloading. 

 An ‘overloaded function’ refers to a 

function having more than one distinct 

meaning. 
162) Write the general syntax and example 

for function prototype? 

 <type> <function identifier> 

<(arguments)> 
163) How are the functions invoked in 

function overloading? 

The compiler adopts BEST MATCH strategy 

 Look for the exact match of a function 

prototype with that of a function call 

statement 

 In case an exact match is not available, it 

looks for the next nearest match. That 

is, the compiler will promote integral 

data promotions and then match the call 

statement with function prototype. 
164) What is Operator overloading? 

 The mechanism of giving special 

meaning to an operator is called as 

operator overloading. 

 The term operator overloading, refers to 

giving additional functionality to the 

normal C++ operators like +,++,-,—

,+=,-=,* <,>. 
165) Mention any two rules for Operator 

overloading? 
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 Only existing operators can be 

overloaded. New operators cannot be 

created. 

 The overloaded operator must have at 

least one operand of user defined type. 
166) Define Constructor? 

 When an instance of a class comes into 

scope, a special function called the  

constructor gets executed.  

 The constructor function initializes the 

class object. 
167) What are the functions of 

constructor? 

 The constructor function initializes the 

class object 

 The memory space is allocated to an 

object 
168) What is Copy constructor? 

 Copy constructor is executed: 

1) When an object is passed as a 

parameter to any of the member 

functions. 

Example void add::putdata( add x); 

2) When a member function returns an 

object. For example, add getdata(); 

3) When an object is passed by 

reference to constructor. 
169) Define destructor? 

 When a class object goes out of scope, a 

special function called the destructor 

gets executed. 

 A destructor is a function that removes 

the memory of an object which was 

allocated by the constructor at the time 

of creating a object.  

 It carries the same name as the class tag, 

but with a tilde ( ~) as prefix. 
170) What are the advantages of 

Inheritance? 

 Reusability of code: Code developed 

for one application can be reused in 

another application if such functionality 

is required. This saves a lot of 

development time. 

 Code sharing: The methods of the base 

class can be shared by the derived class. 

 Consistency of interface: The inherited 

attributes and methods provide a similar 

interface to the calling methods. 
171) What is base class? 

 A base class is a class from which other 

classes are derived.  

 A derived class can inherit members of a 

base class.  
172) What is derived class? 

 A class created from an existing or base 

class is called derived class. 

 The derived class inherits all the 

properties of the base class. 
173) What is meant by Accessibility? 

 When a member of a base class can be 

used by the objects or the members of 

the derived class. This is called as 

accessibility.  

 The three access specifiers are private, 

protected and public. 
174) What is Abstract class? 

 Classes used only for deriving other 

classes are called Abstract classes. 

 Objects for these classes are not 

declared. 
175) What are the types of Inheritance? 

 There are different types of inheritance. 

Single Inheritance, Multiple inheritance, 

Multilevel inheritance, hybrid 

inheritance and hierarchical inheritance. 
176) What is Multilevel Inheritance? 

 When a class is derived from a class 

which is a derived class itself – then this 

is referred to as multilevel inheritance. 
177) What is meant by e-learning? 

 e-Learning that enables online 

educational programs leading to 

degrees and certifications. 
178) What is meant by e-banking? 

 e-Banking permits banking from the 

comfort of the home by using internet 

facilities.  
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 It has truly improved the reach and 

services of banks. 
179) What is ATM? 

 ATM (Automated Teller Machine) 

enables withdrawal of money from the 

accounts in a particular bank anytime 

and anywhere.  

 This helps the user in emergency  

situations where money is needed 

during the nights and holidays. 
180) Write a note on emotion containers? 

 They are small compartments with a 

screen, speaker and a scent to derive 

emotional comfort.  

 This can prevent people from acquiring 

bad habits. 
181) What is Memo frame? 

 Easy interaction with other people 
through touch screen, scanner and 

microphone facilities. 
182) What are the three technical elements 

a common man needs to reach out the 

benefits of IT? 

 • Connectivity [Computer networks and 

Internet facility] 

 • Affordable computers or other similar 

devices 

 • Software 
183) What is e-shopping? 

 Purchasing any product, any brand, and 

any quantity from anywhere using 

internet facilities is called e-shopping. 
184) What is the use of Call centres? 

 A call center is defined as a telephone 

based shared service center for specific 

customer activities. 

 Call centres are used for number of 

customer-related functions like 

marketing, selling, information transfer, 

advice, technical support and so on. 
185) Define Data management? 

 Data Management is a category of IT 

Enabled Services pertaining to 

collection, digitization and processing 

of data coming from various sources. 

 It is the key for effective and profitable 

use of IT in organizations. 
186) What is Medical transcription? 

 Medical Transcription is a permanent, 

legal document that formally states the 

result of a medical investigation.  

 It facilitates communication and 

supports the insurance claims. 
187) What is Data digitization? 

 Digitization refers to the conversion of 

non-digital material to digital form.  

 A wide variety of materials as diverse as 

maps, manuscripts, moving images and 

sound may be digitized. 
188) What is IT Enabled Service? Write 

any four IT Enabled Service? 

 Information Technology that helps in 

improving the quality of service to the 

users is called IT Enabled Services 

[ITES].  

 IT Enabled Services are human intensive 

services that are delivered over 

telecommunication networks or the 

Internet to a range of business segments. 

ITES greatly increases the employment 

opportunities. 

 Some of the IT enabled services are: 

• e-Governance 

• Call Centers 

• Data Management 

• Data Digitization 
189) Write note on e-governance? 

 Computers help to look at the 

government websites and the services 

provided by them.  

 The various websites provided by the 

government give the details about the 

departments, specific functions, special 

schemes, documents, etc. 
190) What is Cyber Laws? 

 Computer crimes require special laws to 

be formed by the government. 

Different countries have different ways 

of making the laws and awarding 
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punishment to those who commit the 

crimes.  

 India has Cyber laws to prevent  

computer crimes. 
191) What is meant by Piracy? 

 Making and using duplicate hardware 

and software is called Piracy. 
192) Define Virus? 

 A virus is a self-replicating program 

that can cause damage to data and files 

stored on your computer.  

 These are programs written by 

programmers with great programming 

skills who are motivated by the need for 

a challenge or to cause destruction. 
193) Define Cracking? 

 Cracking is the illegal access to the 

network or computer system. Illegal 

use of special resources in the system is 

the key reason for cracking.  

 The resources may be hardware, 

software, files or system information. 

 Revenge, business reasons and thrill are 

other common reasons for committing 

this crime. 
194) What is Computer crime? Write any 

two common crimes?  

 A computer crime is any illegal activity 

using computer software, data or access 

as the object, subject or instrument of the 

crime. 

 Common crimes include: 

• Illegal access to confidential files 

• Stealing hardware 

• Selling or misusing personal 

• Hardware and software piracy 

• Virus 

• Cracking 
195) What is meant by theft of computer 

crime? 

 Idle time of computers in an 

organization is being stolen illegally. 

 Some other software runs on an idle 

computer without the knowledge of the 

organization. This is called theft of 

‘computer time’. 
196) What are Computer ethics? 

 Computer ethics are general guidelines 

on ethics are useful responsibly in their 

application of information technology. 

 General guidelines on computer ethics 

are needed for: 

• Protection of personal data 

• Computer Crime 

• Cracking 
197) List out the data security methods? 

 Physical security 

 Personal security 

 Personnel security 
198) List out the Website services by using 

computer? 

 Agriculture Marketing Network 

 Career guidance 

 Employment Online 

 General Provident Fund 

 Results of various Examinations 
199) What is Physical security? 

 Physical security refers to the protection 

of hardware, facilities, magnetic disks, 

and other items that could be illegally 

accessed, stolen, damaged or destroyed.  

 This is usually provided by restricting 

the people who can access the resources. 
200) What are Personal and Personnel 

security? 

 Personal security refers to software 

setups that permit only authorized 

access to the system. User Ids and 

passwords are common tools for such 

purpose.  

 Personnel security refers to protecting 

data and computer system against 

dishonesty or negligence of employees. 
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